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 1 Mechanics of Data Input.
Most of the data fields in XspouseTM  are numeric. Some are display toggle fields. 

Some of the data entry fields have a raised, button-like appearance. This indicates 
that there is a data detail input window associated with these fields. When the 
cursor highllight is in one of these fields the “Detail” option becomes active on the 
tool bar. If you press the “Detail” option, or press the “D” key or double-click the left 
mouse button when such a field is highlighted, a detail input window will open 
providing  you with more options for entering information for that field. Some of the 
more important detail windows are illustrated in the section on Detail Windows.

For example Figure 1 shows the main screen with the highlight in the father's 
Other taxable income input field. If you double-click the left mouse button or press 
the “D” key when in such a field, a detail input window opens as shown in Figure 2.

Figure 1  Main Xspouse input screen showing highlight on one of the button-like input 
fields.

Where there are data fields that appear as recessed buttons, these are option 
display fields that can be toggled through by pressing the space bar of by pressing 
the right mouse button to move forward through the options or the backspace key 
to move backwards through the options when highlighting the field. Examples of 
such fields are the case year, Monthly/Annual figures, the and optional screen 
display windows at on the right side of the main window, Cash flow. Such display 
toggle options also appear in the various detail and setting screens.
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Figure 3  Shows the display of toggles for the Monthly/Annual screen display and the Year.  
Option selection is made by pressing the space bar or by clicking the right mouse button 
when in that field to move through the options or by pressing the back space key to move 
backwards through the options . 

 1.1 Copy/Paste in  XspouseTM

You can copy/paste from/to numeric input cells (i.e. cells into which you can type 
numbers) in XspouseTM  using the standard Windows key combinations Ctrl+C 
(copy) and Ctrl+V (paste). You cannot copy/paste using the mouse.

It is helpful to understand how the paste operation in XspouseTM  works. 

If you paste a string of characters, XspouseTM  will process the characters one-by-
one as if they had been typed at the keyboard. Inappropriate characters will be 
ignored. The following examples illustrate some unexpected results that may occur. 
(Paste the suggested strings into one of the Wage Income cells in the main 
screen.)

  Example 1
Paste 1234.56

The result is 1234

Explanation: XspouseTM  ignores the digits after the decimal point 
because the Wage Income cell expects a whole number.

  Example 2
Paste 123456789

The result is 1234567

Explanation: XspouseTM  ignores the last two digits (8 and 9) because 
the Wage Income cell accepts a maximum of seven digits.
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  Example 3
Paste 12a3b4

The result is 1234

Explanation: XspouseTM  ignores the non-numeric characters `a' and 
`b'.

 1.2 Windows Calculator

The Windows Calculator is available under the Tools menu selection in the main 
screen of XspouseTM  (and XarrearsTM).

The Windows Calculator can be used anywhere in XspouseTM . You can copy and 
paste numbers between the calculator and XspouseTM  as described above. If you 
want to use the calculator with one of the XspouseTM  dialogs, you should start the 
calculator before opening the dialog. This is because the dialog will disable the 
main screen of XspouseTM  (including the main menu) and the Windows Calculator 
will be inaccessible.

 1.3 Present and Future Value Calculators

The PV and FV Calculators are available under the Tools menu selection in the 
main screen of XspouseTM  (and XarrearsTM).

With both calculators it is possible to calculate future or present values of a stream 
of payments or to set a desired present or future value and calculate the required 
stream of payments. 

To copy a present value or future value you first have to make the Present Value 
field an input field. You do this by toggling the last field ("Specify Present Value?") 
to Yes. You can now high-light the present value and copy it with Ctrl+C.
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Figure 4 When using the present value calculator you have the option of allowing 
the calculator to calculate the value of a stream of payments or you can select a 
future value and have the calculator calculate the payment amount.
With the future value calculator a similar option is available to either calculate the 
future value of a stream of payments or to set a future value and calculate the 
required stream of payments.
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 2 Xspouse Layout
This section describes the layout of XspouseTM . You will find a complete 
description of the various screens and topics here that are mentioned later in this 
manual.

On the main screen tool bar the icon labeled Wiz/Pro (Wizard/Professional) toggles 
between the data input Wizard and the Professional screen. Experienced users will 
prefer the Professional screen. However, even experienced users should take a 
look at the Wizard. The pages in the Wizard explain what XspouseTM  does with 
the data entered on each line.

 2.1 Main Screen (Professional Screen)

Figure 5  Main screen (Professional screen)

This screen is the operational center of XspouseTM. All other program features are 
accessible from here, via the menu selections and icons at the top of the screen.
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 2.2 Wiz/Pro – Data Input Wizard

The Data Input Wizard is a companion screen to the main (Professional) screen. It 
provides direct onscreen help to assist the user with the selected input fields. You 
can toggle back and forth between the Professional and Wizard screens by clicking 
the Wiz/Pro (Wizard/Professional) icon on the extreme right of the icon bar.

The data entry cells in the wizard are the same as in the main screen, but are 
arranged in pages instead of rows. Each page displays text about the selected 
input field to aid user input.

Data entry in the main screen and the wizard are completely equivalent. Data that 
is entered through the wizard will appear in the main screen and vice versa.

Figure 6  Data input Wizard
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 2.3 The Professional Screen

As mentioned earlier, the Professional screen is the operational center of 
XspouseTM . 

The Professional screen is divided into three parts:

1. The left side of the screen is for data input;

2. the middle displays the child and spousal support for the Guideline and 
Proposed settlements; while 

3. the right side displays whatever View you have selected. The default view is 
“Cash flow”.

The various menu bar selections and tool bar icons lead to a particular program 
feature. Although we will describe everything later, there are three of these 
program features that you should be familiar with:

• Selecting the View option on the main menu lets you choose what you to 
see displayed on the right hand side of the Professional screen. 

• The Settings and Tax Settings icons in the tool bar allow you to customize 
the case environment.

 2.3.1 Data Entry and Display

The left side of the Professional screen is for entering income and expense data for 
each of the two spouses. If uncertain about what data should be entered in to a 
particular field, switch to the Wizard view for a description of what data should be 
entered into the field.

Alternatively, when the Data Detail display option is selected, the detail for the data 
input field highlighted on left of screen will be displayed on the right of the 
Professional screen. You can enter all of your detail data via this “Data detail” 
display on the right instead of using the individual Detail windows for each input 
field if preferred.

When you type directly into a cell that has a detail window attached, the numbers 
will be in red text. This is to alert you later that you have not used the detail 
window. The red text feature may be switched on/off through File > Preferences if 
preferred. XspouseTM  will remember the selected option and when you later switch 
the feature back on, the appropriate cells will be displayed with red text again. If 
you delete a value marked in red font, the red font setting will be removed.

Some of the cells may have an asterisk (*) next to them. This means that 
XspouseTM  is automatically calculating the data in such a cell. Please click the 
Wiz/Pro icon and see the data input Wizard page for such a cell for an explanation 
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of what is happening.

 2.3.2 Data Input Categories

The main screen of XspouseTM  is modeled on Family Code sections 4058-4059, 
IRS Form 1040 and Schedule A, and FTB Form 540 and Schedule CA(540).

XspouseTM  meticulously follows the guideline calculations defined in the Family 
Code and the tax calculations defined in the federal and state tax forms. To this 
end, XspouseTM  allows the user to enter income in all the categories specified in 
FC 4058, IRS Form 1040 and FTB Form 540; and it allows the user to enter 
deductions in all the categories specified in FC 4059, IRS Schedule A and FTB 
Schedule CA(540).

  Detail Windows
As noted previously, all data entry buttons that are raised from the background 
indicate that a detail input window is available for entering data.  This can be 
accessed by double clicking the left mouse button or by pressing the “D” key or 
using the “Detail” menu item when the particular button is highlighted. 

You should use the detail windows on the lines where there is one.

  FC 4058
You can enter income in all categories specified in FC 4058 on the lines

• Wages+salary 

• Self-employed income 

• Other taxable income

• Other non-taxable income

• Use the detail windows on the lines where there is one.

  FC 4059
You can enter deductions in all categories specified in FC 4059 on the lines

• SS paid prev marriage

• CS paid prev marriage

• Health insurance

• Required union dues

• Mandatory retirement

• Hardship deduction

• Other GDL deductions
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  Note on Health Insurance
Health insurance premiums also enter into tax calculations. They are included 
among the medical expenses on Schedule A.  For self-employed persons, it gives 
rise to an Adjustment to Income (XspouseTM  calculates this). This ATI may not be 
equal to the actual premium paid.

• If you do not wish the premiums to be considered in tax calculations, enter 
them as Other GDL deductions.

• If you do not wish the premiums to be FC 4059(d) deductions, enter them as 
Other medical expenses.

  IRS Form 1040
You can enter income in all categories specified in IRS Form 1040 on the lines

• Wages+salary

• Self-employed income

• Other taxable income

You can enter all Adjustments to Income specified in IRS Form 1040 on the lines

• Adjustments to Income

• SS paid prev marriage

  IRS Schedule A
You can enter deductions in all categories specified in IRS Schedule A on the lines

• Health Insurance

• Other medical expense

• Property tax expense

• Deductible interest expense

• Contribution deduction

• Miscellaneous tax deductions

• Required union dues

  FTB Form 540
This form uses the federal amounts from Form 1040 in most cases. If you have a 
special case that requires a modification of the state AGI, you can do so in the 
detail windows for Other taxable income and New spouse income. In both these 
detail windows, you will see (near the bottom) lines for adding to or subtracting 
from state AGI.

  FTB Schedule CA(540).
This form uses the federal amounts from federal Schedule A. and makes 
appropriate adjustments for state taxes.
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 3 Reconciliation of Differences.
Inevitably, there will often be cases when seemingly the same data produces 
differing support amounts. This may occur even when counsel for both parties are 
using XspouseTM . The correspondence between the data input fields in 
XspouseTM  and the income and deduction categories in Family Code and Tax 
Codes suggests a standard strategy for discovering the reasons for such 
differences.

1. Check the program settings, such as the filing statuses. If there is a warning 
“Settings changed” on the main screen, open the Settings screen and see 
which settings are marked in red. These are the ones that have been 
changed from the shipped defaults. 

2. Look at Reports > Income Declaration. This report lists all the income and 
deduction categories specified in FC 4058 and 4059. Is there a difference in 
any of these categories? 

3. Frequently, the difference will be in the deduction for federal and state 
income taxes paid. If this is the case, look at Taxes > Federal Tax Forms > 
Form 1040 and Taxes > State Tax Forms > Form 540. You need not go 
through the actual calculations. Just note the line where there is a 
difference. If necessary, go to the form that calculates that particular line. 
(For example, if there is a difference in the federal Alternative Minimum Tax, 
look at IRS Form 6251, which computes this tax.)

4. Check that the number of children qualifying for the Earned Income Credit 
and Child Tax Credit is correct. These numbers are specified in the 
Exemptions detail window. 
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 4 Some Special Data.
  Exemptions.
If you find it necessary to modify the contents of the Exemption detail windows 
manually, make sure that you have first entered all children (both this and other 
relationships) in the Detail window associated with Line 1. If you do not, 
XspouseTM  will reason that, since there are no children, there are none qualifying 
for any of the credits and will override any values that you enter.

  Partial Hardships.
These can be entered in the Hardship detail window. They can also be entered 
through the Settings screen. The two methods are entirely equivalent.

In the Settings screen, towards the bottom, there are two percentages, one for 
each parent. The default is 100% (full hardship) but these percentages can be 
changed.  Simply divide the desired number of hardships by the number of other 
supported children with that parent.

  Example 4
Assume that there are 2 other supported children with father. To award 
1.5 hardships to father, change the percentage on father's side to 75% 
(per child hardship = 1.5 divided by 2 = 0.75).

  Child Care Expenses
For most calculations, only a knowledge of the total child care expenses is 
necessary. The one exception is the calculation of per child add-ons in the 
Findings and Rebuttals report.

The child care expenses can be either equally or unequally divided between the 
children. In the top right corner of the Findings screen, there is a toggle that 
specifies how the total expenses are divided between the children. The default is 
"Equally". However, this can be changed to "allocated by User" by right mouse 
button. When this is done, a button labeled "Allocate" pops up. Clicking this button 
opens a dialog in which per child expenses can be entered for each child and each 
parent.

XspouseTM  keeps track of events that make it necessary to allocate the expenses 
de novo and posts a warning when appropriate.
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 4.2 Shortcuts

The following keys have the effect described on the right.

B [Bump] Toggles between adjusted (bumped) and unadjusted 
(unbumped) spousal support

D [Detail] Opens a detail window when positioned on a data cell that has a 
detail associated with it.

E [Exemptions] Toggles IRS 8332 releases on/off. This affects only the 
Proposed settlement. Choosing whether to release or not release 
exemptions generally has a major effect on Proposed spousal support 
and the tax savings associated with it.

F [Findings] Displays the Findings and Rebuttals.

I [Input] Toggles between monthly and annual figures.

P [Print] Displays the Print menu

R [Range] Toggles the display of the FC 4055 (f)(7) low-income range of 
child support at incomes when this is applicable. When this feature is 
active, pressing Ctrl+R in the Professional screen will toggle the 
Guideline child support between the high and low ends of the range.

Note: Using R to switch off the display of the low-income support range 
will also switch the automatic CPI adjustment to YES (the default 
setting)

L [Low] Toggles the automatic CPI adjustment of the low-income 
adjustment threshold. Switching the automatic CPI adjustment to NO 
automatically switches the child support range display to YES and the 
red Settings changed alert is displayed.

S [Settings] Displays the Settings screen.

T [Tactic] Displays the Tactic dialog.

U User-specified Child Support.

V User-specified Spousal Support

W Formula SS

X [Tax Settings] Displays the Tax Settings dialog. The yellow cursor must 
be positioned in either the husband's or wife's data input column.

Ctrl+C Copy from an input cell.

Ctrl+V Paste to an input cell.

You can change the child support calculation from Guideline to User CS (or vice 
versa) by right-clicking on it. Similarly, you can change the spousal support formula 
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by right-clicking on it.

Note that if you choose User CS for child support, FC 4055 Checking will be 
switched off. Please refer to the manual section on the Findings and Rebuttals 
report for more information on FC 4055 Checking.

 4.3 Center of the Screen: Support

There are two boxes in this part of the screen, displaying the support amounts for 
the Guideline and Proposed settlements.

  Guideline
In the box labeled Guideline, you will see the figures for guideline nets for both 
spouses and the amounts of child support, spousal support and mandatory add-
ons (child care expenses.) The nets will be labeled as either adjusted or 
unadjusted, depending on whether the tax effects of spousal support are being 
considered. Please note that the displayed nets are the ones that are used to 
calculate spousal support. The net to calculate child support may contain an 
additional amount of new spouse or significant other income; see View > Guideline 
Summary for details. The higher of the two nets will be in blue. Because of limited 
space in the Professional screen, support payments made by the high-earner to 
the low-earner are displayed as positive numbers. If support is paid by the low-
earner to the high-earner, it is displayed as a negative number. (Thus a guideline 
child support of -1000 (negative 1000) indicates a payment of $1,000 by low-earner 
to high-earner.) In most other XspouseTM screens and printouts, there is sufficient 
room to explicitly state who pays whom, and you will not have to deal with negative 
support values.

  Proposed
The box labeled Proposed displays the portions of proposed support that have 
been designated as non-deductible and deductible for tax purposes.

The line labeled Saving tells you how much the two parties save compared to the 
Guideline settlement. (These savings are through reduced combined taxes.)

The last line displays the number of exemptions being released by the low-earner 
to the high-earner. You should always press the `E' key to toggle the releases on 
and off, and compare the savings with and without releases.

 4.4 Right of the Screen : The View

This portion of the screen is described under the View section below.
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 5 The Main Menu

 5.1 File 

Most of the selections in this menu are the standard ones found in most programs. 
One particular to XspouseTM is the Preferences selection. This allows you to 
customize various features (mainly affecting appearance) in the program. 

 5.2 View

There are five views in this menu. 

 5.2.1 Data Detail 

This view is for entering data. It displays, and allows you to enter, the detail data as 
you move from cell to cell. On the lines that have a Detail window (see Section 3.5) 
associated with them, the Data Detail view replicates the contents of the Detail 
window. On lines that have no associated Detail window, the Data Detail view is 
blank. This view is intended for initial data entry and is useful for checking data 
after it has been entered. 

 5.2.2 Cash Flow 

This view presents cash flow data and compares the Guideline and Proposed 
settlements. 

The first section displays the combined net spendable income under the two 
settlements. 

The next two sections display identical data, one for father and one for mother. 

 5.2.2.1 Cost

Cost is:
CS paid + SS paid - tax saving ............................(1)

Tax saving is the saving resulting from the payment of SS. 

Note that the amounts for CS and/or SS will be positive for a payor, negative in the 
case of a recipient. Tax saving will be negative in the case of a recipient of SS, 
because this results in a tax liability. 
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  Example 5. 
Using default settings of one child with mother and 20% of time with 
father, enter 6000 wages for father and 3000 wages for mother. 
Guideline CS is 858 and Santa Clara SS is 279, both paid by father. 
Now look at the Total taxes line in father's cash flow (in the 
Guideline column). We see 1465. Next, go into the Settings screen and 
exclude spousal support. Now (with no spousal support), we see that 
the taxes for father are 1491. 

Thus, the payment of guideline spousal support results in a tax saving 
of 1491-1465 = 26. Substituting these numbers into the Cost formula 
(1) above, we get 

Cost = 858 + 279 - 26 = 1111
 

Now, go into the Settings screen and switch spousal support back on. 
The displayed cost for the father is indeed 1111.

 5.2.2.2 Net spendable income 

Net spendable income is the amount of unadjusted guideline net remaining after 
the cost has been deducted. 

  Example 6b
In the preceding example, father's unadjusted guideline net is 4509. 
(Press the `B' key to see this. Now press the `B' key again to restore 
adjusted nets.) If we subtract the cost (calculated above), we get 

Net spendable income = 4509 - 1111 = 3398, which is what is displayed 
in Xspouse. 

 5.2.2.3 Increase over guideline 

Increase over guideline is the dollar increase of the net spendable income over the 
amount in the guideline column. 

  Example 7
Press the `B' key to make sure that the adjusted nets are displayed 
(in the Guideline box in the center of the screen). In the Proposed 
column, father's net spendable income is 3427. The increase over 
guideline is 3427 - 3398 = 29. 

 5.2.2.4 % of combined net spendable

% of combined net spendable is the net spendable income of the spouse 
expressed as a percentage of the combined net spendable income. 
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  Example 8. 
Continuing with the example above, father's net spendable income 
(Guideline column) is 3398. The combined net spendable income 
(Guideline column) is 7397. Thus, father's percentage of the combined 
net spendable is 3398/7397, or 46%. 

 5.2.2.5 % of saving over guideline

% of saving over guideline is the increase over guideline expressed as a 
percentage of the total saving over guideline. 

  Example 9
In the Proposed column, we saw above that the increase in father's net 
spendable income over guideline is 29. The total saving over guideline 
is 31, which is the sum of the father's and mother's savings over the 
guideline (see the Proposed box in the center of the Professional 
screen). The percentage is (29/31 = 95%).

 5.2.2.6 Total taxes

Total taxes are the sum of income and employment taxes. In the case married filing 
jointly, they are the prorated portion for the spouse in question. See the note at the 
end of the Reports section below for an explanation of how this proration is done 
in XspouseTM. NOTE: This line may have a blue uppercase A next to it. This 
means that either the Federal or State Alternative Minimum Tax has been 
triggered. 

 5.2.2.7 Exemption value

Exemption value is an estimate of the total value of the exemptions to the spouse. 
With the passage of the TCJA these are currently zero.

 5.2.2.8 Number of withholding allowances

Number of withholding allowances is the number of allowances that the spouse 
should claim on his or her W-4 form. NOTE: This line may have a blue lowercase w 
next to it. This means that the spouse in question should arrange for additional 
withholding (or pay estimated taxes) to avoid having to pay tax at the end of the 
year. 

 5.2.2.9 Net wage paycheck

Net wage paycheck is the paycheck that the spouse can expect with the suggested 
number of withholding allowances. 

 5.2.3 Income Tax 

This view presents a summary of Federal and State income taxes. 
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You will find a detailed, line-by-line documentation of the tax calculations under the 
main menu item Taxes > Tax Forms and then toggling between Federal and State 
tax forms. 

 5.2.3.1 Medicare surcharge

A Medicare surcharge commenced from the beginning of 2013 as a result of the 
Patient Protection and Affordable Care Act (PPACA). This is an additional levy on 
higher incomes  above certain thresholds based upon filing status and also 
encompasses a 3.8% tax on unearned income above the thresholds. The 
calculation of the surcharge is straightforward. However under filing status of 
married filing jointly can lead to some confusion unless the overall situation is taken 
in to account. It is easiest to explain the calculation via a simple example. 

To calculate surcharge under the MFJ situation the process in Xspouse is to use 
the "wisdom of hindsight" of knowing what the total wage income is for the married 
unit (MFJ), deduct the MFJ threshold of $250,000, then apportion the Medicare 
surcharge based upon each spouse's contribution to incurring the surcharge. 

In actual fact, the "timing" of the collection of the surcharge will be done as soon as 
the wage income of the individual passes the individual threshold of $200,000 and 
withheld, but the actual amount due will be determined by the filing status.

This approach has been taken to be consistent with scenarios whereby neither 
spouse in an MFJ situation has a wage income exceeding the individual threshold 
of $200,000, but jointly they exceed the MFJ threshold of $250,000. For example 
wife earns $175,000 and husband earns $100,000. Neither will have the additional 
0.9% Medicare withheld, though they are liable for the surcharge on $25,000 by 
filing as MFJ. The flip side of this is where one spouse's wage income in the MFJ 
situation exceeds the $200,000 but not $250,000, whilst the other spouse does not 
work. Although the working spouse will have the surcharge withheld from wages, it 
will be a tax overpaid and need to be offset against other taxes or refunded at the 
end of the year.

The only equitable way of apportioning the Medicare surcharge in an MFJ situation 
is on the basis of each spouse's contribution to the generation of the surcharge as 
done in Xspouse. This can only be done by using the "hindsight" approach and to 
distribute the surcharge in proportion to each form of income earned by each 
spouse. This approach has been applied to all calculations of the Medicare 
surcharge in the MFJ situation. Not only is this the only equitable way to apportion 
the surcharges, but by doing so maintains consistency with how other taxes are 
apportioned in the MFJ situation by all calculators when calculating the guideline 
net incomes.

 5.2.3.2 Net Investment Interest Tax (NIIT)

The NIIT is the Medicare surcharge on unearned income. Xspouse provides 
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detailed inputs for investment income items under Other taxable income and also 
under Other taxable income for New spouse income to allow for calculation of the 
surcharge under the MFJOUT situation.

In addition to the extra detail for input of investment income, there are provisions in 
the detail windows for Ded interest expense and Misc tax deductions to enter 
investment income expenses that are included in the calculation of the NIIT.

The surcharge on net investment income is shown on Line 8 of Schedule 2 of form 
1040 under the Taxes>Tax forms on the main menu and displayed on the Income 
Tax view..

 5.2.4 Employment Tax 

This is a summary of Federal and State employment taxes. 

 5.2.5 Guideline Summary 

This view supplements the Income Declaration (see Reports > Income 
Declaration). It provides additional details about the guideline support calculations. 

Net SS is the spousal support calculated by applying the guideline spousal support 
formula to the guideline nets. In the case of Floating Shares, this is always equal to 
the actual spousal support paid. 

Equalizing payment is the additional payment that is necessary under Fixed 
Shares to restore the ratio of the adjusted net disposable incomes to the same 
value as the ratio of the unadjusted net disposable incomes. This payment is 
always zero under Floating Shares. 

Note that the disposable income is not the same as the spendable income in the 
Cash Flow view. To calculate disposable income, we subtract the amount allocated 
for child support, whereas to calculate spendable income, we subtract (or add) the 
actual child support paid. 

 5.3 Reports 

 5.3.1 Findings and Rebuttals. 

This report displays a per-child breakdown of guideline child support. If you have 
entered child care expenses in the main screen, then you can designate a per child 
allocation here, or you can choose to let XspouseTM allocate these expenses 
equally between the children. 
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  Mandatory Addons 
For most calculations, only a knowledge of the total child care expenses is 
necessary. The one exception is the calculation of per child add-ons in the 
Findings and Rebuttals report. 

The child care expenses can be either equally or unequally divided between the 
children. In the top right corner of the Findings screen, there is a toggle that 
specifies how the total expenses are divided between the children. The default is 
"Equally". However, this can be changed to "allocated by User". When this is done, 
a button labeled "Allocate" pops up. Clicking this button opens a dialog in which 
per child expenses can be entered for each child and each parent. 

XspouseTM keeps track of events that make it necessary to allocate the expenses 
de novo and posts a warning when appropriate. 

  Basic Child Support 
There are two modes for the Findings and Rebuttals report. One mode simply 
displays the same information as the per child information in the printout of the 
main screen in XspouseTM. In the second mode, the Findings and Rebuttals report 
becomes a powerful input screen. It is designed to give judicial officers complete 
control over basic child support in FC 4055(b)(7) and FC 4057 cases. 
The mode depends on whether the setting Display FC 4055(b)(7) low-income CS 
adjustment range is toggled to YES or NO in the Settings screen. The mode should 
be selected before opening the Findings and Rebuttals report. There is a shortcut 
in the main screen of XspouseTM to do this. Simply press the `R' key on your 
keyboard to toggle between the two modes. 

You can easily see which mode is active by looking at the bottom of the Guideline 
box in the center of the XspouseTM main screen. When the Findings and Rebuttals 
report is in input mode, you will see either the FC 4055(b)(7) adjustment range or 
(at higher incomes) a little hyphen there. 

  When Display FC 4055(b)(7) low-income CS adjustment range is 
toggled to NO in the Settings screen. 
This is the static display mode. The displayed per child information is identical to 
that in the printout of the main screen of XspouseTM. 

  When Display FC 4055(b)(7) low-income CS adjustment range has 
been toggled to YES in the Settings screen. 
Three new columns are displayed under the heading "Family Information". The 
numbers in these columns are NOT per child information - they refer to the child 
support payable when the child in question is the oldest supported child. The Basic 
CS may be manually changed to any amount in the range permitted by FC 4055(b)
(7). This can be done by typing in the desired amount in any cell; or by pressing 
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[Ctrl+R] to toggle the amounts between the high and low ends of the ranges. 

There is a calculation aide attached to each of the Basic CS cells. To access it, 
press the `D' key while the yellow cursor is positioned on any of the Basic CS cells. 

  Example 10
Use the Child detail window to enter 3 children with mother. Name the 
children Huey, Dewey and Louie. 

In the main screen, enter 1000 monthly wages for father and 0 for 
mother. 

In the main screen, press 'R' to switch on the Low Income Adjustment 
range display. 

From the main menu open the Findings screen or from the Reports > 
Findings option. 

The Basic CS opposite Huey (the oldest child) is the child support for 
all 3 children. 

The Basic CS opposite Dewey is the child support when only Dewey and 
Louie are being supported. 

The Basic CS opposite Louie, the youngest child, is the child support 
when only Louie is being supported. 

Note: With the passage of Assembly Bill 2393 the low income adjustment 
threshold was increased to $1,500 from January 1, 2013 and indexed for inflation 
on March 1, every year thereafter. Details of implementation of these changes are 
presented in Section 7.1.

In cases where the court decides that child support should be modified in 
accordance with FC 4057, the automatic checking for FC 4055 compliance in 
XspouseTM can be switched off. Judicial officers have full control over the data in 
the Findings and Rebuttals report. 

There is a toggle in the Findings screen (just above the per-child information, on 
the right) that allows the user to specify whether basic child support amounts 
should be checked for compliance with FC 4055. 

When FC 4055 checking is ON, the amount in each Basic CS field is checked for 
FC 4055 compliance. The payor of each of the basic child support figures is 
automatically calculated and cannot be changed manually. 

In contrast, when FC 4055 checking has been toggled to OFF, a Basic CS button is 
displayed at left of screen that opens up a detail input screen allowing any amount 
to be typed into any of the basic child support fields. In addition, the Payor fields 
(next to the Basic CS fields) are now toggle fields (right-click on them to change 
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them). 

If  FC 4055 checking has been toggled to OFF a warning Settings changed will 
appear on the main screen.

  Remarks. 

1. When FC 4055 checking is toggled back to ON in the Findings screen, all 
user entered Basic CS amounts and payors revert to guideline. The fields in 
the Payor column cease to be toggle fields and become simple labels. 

2. In the printout of the main screen, an informational message indicating 
whether FC 4055 checking is ON or OFF is printed. 

 5.3.2 Income and Expenses 

This reports is self-explanatory. 

 5.3.3 Client Financial Summary 

This reports is also self-explanatory. 

 5.3.4 Settlement Possibilities 

The data in this report depend on the tactic that has been chosen in the 
Professional screen. You can study the variation in tax savings and spendable 
incomes as spousal support goes through a range of possible values. You can 
specify the number of exemptions that are going to be released via IRS Form 
8332. (This release is always from the low earner to the high earner.) 

 5.3.5 Bonus Income Reports 

Taxes are calculated on annual income (taxable income), whereas guideline 
support is calculated on monthly income (guideline nets). The Professional screen 
in XspouseTM deals with situations in which income is constant from month to 
month. The Annual Bonus and Variable Bonus Income reports augment the 
Professional screen by considering cases when income varies from month to 
month, or has "spikes". The two bonus reports calculate the effect of such spiked 
income on guideline nets and the resulting child and spousal support. 

Bonus income may produce two side effects. 

1. Bonus income may trigger a change in child and/or spousal support 
payments to or from a spouse from a prior relationship.

2. Bonus income has a direct tax consequence because it is taxable income. It 
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may also have an indirect tax consequence if it triggers a change in spousal 
support payments to or from a spouse from a prior relationship 

XspouseTM deals with such side effects in the following manner. 

1. XspouseTM makes an appropriate adjustment to "CS paid for a prior 
relationship" and "SS paid for a prior relationship" when computing guideline 
net that includes the bonus. 

2. XspouseTM prorates the additional (annual) taxes between the twelve 
months, in proportion to the size of the bonus in each month. The taxes are 
said to be "Apportioned". XspouseTM then makes an appropriate adjustment 
to "Other Nontaxable Income" when computing guideline net that includes 
the bonus. 

One special situation needs mention in connection with the apportionment of taxes. 
This is the case when the two spouses file MFJIN. In this case, the additional taxes 
are "apportioned" in proportion to the joint bonus in each month. The taxes are 
then split between the two spouses in the normal fashion (see below). These splits 
of the joint taxes between the spouses will generally vary from month to month, 
because of the unevenness of the bonuses (in some months father may earn 
more, in others mother may earn more). 

 5.3.6 Split of Joint Taxes in XspouseTM. 

This documentation applies to XspouseTM calculations generally, not just to the 
Bonus Income reports. 

When two spouses file jointly (either MFJIN or MFJOUT), XspouseTM 

1. Splits the income taxes between the spouses in proportion to their 
respective gross taxable incomes.

2. Attributes the employment taxes (social security, self-employment, state 
disability insurance) to the spouse who incurred those taxes. (Both spouses 
may have such taxes.) 

Both the Annual Bonus Income report and the Variable Bonus Income report 
consist of rows of numbers that have the same format in both reports. It is 
therefore logical to divide the explanation into three parts—the report row format, 
the Annual Bonus Income report and the Variable Bonus Income report. 

 5.3.7 Report Row Format. 

We use the Variable Bonus Income report (in the next section) to illustrate this 
discussion. 
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The first row in each report corresponds to zero bonus and is equivalent to the 
values on the main input screen. Each subsequent row is compared against this 
baseline. Let's take a simple case with a uniform monthly bonus as an illustration. 

  Example 11
In the main input screen, let's use the same data as in Example 5: 
give father 6000 per month wages, mother 3000 per month wages, with 
defaults for everything else. We see that Guideline CS is 858 and the 
Santa Clara guideline SS is 279. Now let's assume that the mother 
receives a monthly bonus of 500, meaning that her income is increased 
to 3500 per month. The CS is now 820 and SS is 162.

This means that the bonus has reduced the CS payment to the mother by 
858-820 = 38; and SS payment by 279-162 = 117.

Now change the mother's income back to 3000 and open the Variable 
Bonus Income report. Make sure that the display is for mother's bonus 
(toggle if necessary). The first step is to enter the 500 bonus that 
we anticipate the monthly bonus for mother in to any of the monthly 
input fields, then clicking the "Replicate" button at the top of the 
screen to fill the other months with the 1000 value. 

Now, let's look at the line for 500 monthly bonus for the mother(first 
column of the table). 

Now look at the row showing 500. The 500 bonus line is highlighted in 
red. Note you may find it more convenient to press the “Browser” 
button to view the report in the browser as this automatically opens 
the report at the bonus row.

The Total CS is 820 and the total SS is 162, as shown above. The 
“cost” is as explained in the note at the bottom of the Bonus table, 
an increase in support paid or a decrease in support received. So in 
this example, the cost to the mother of receiving the 500 bonus has 
been a decrease of 38 in CS plus a decrease in SS of 117 as shown 
above. The percentages are the costs divided by the value of the 
bonus, for CS 38/500 = 7.6% and for SS 117/500 = 23.3%.

A similar calculation occurs if the father receives a bonus. In the 
father's table the bonus row is highlighted in blue.

If both parents receive a bonus, each parent's cost of receiving their 
individual bonus is calculated against other parent's income that 
already includes a bonus. So in the above example if the father also 
received a bonus, his cost would be calculated by calculating the CS 
and SS with and without the bonus when the mother's income is 3500, 
not the 3000 that it is without her bonus.

Let's take a look at the methodology behind all this. When XspouseTM constructs 
the Bonus income table, it does a full guideline calculation for each line of the 
report (the same calculation that recalculates the main screen). All the income and 
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deduction data that are required for the calculation are known in monthly amounts, 
with one exception — taxes. To compute taxes, it is not enough to know the bonus 
in a particular month. Taxes are calculated on annual income. This is where the 
anticipated bonuses come in. They allow XspouseTM to estimate the annual 
income when doing the tax calculation(s). 

This raises the following question: What errors are introduced into the guideline 
calculations (one for each line in the bonus income table) by estimating the 
bonuses and averaging them? It turns out that the errors are quite small. The 
reason for this is the apportionment of taxes. 

When the tax consequences of bonuses are "apportioned", the additional tax for 
which the bonus is responsible is attributed to the month in which the bonus is 
paid. It has very little effect on the other months. Generally, only if our estimates 
are so poor that the real bonuses push the total income into a different tax bracket 
than our estimates, do we get an effect that is felt in other months. Thus, even 
though the total tax depends on the total annual income, the amount of tax 
apportioned to a particular month depends almost entirely on the size of the bonus 
that is paid in that month. 

The following sections outline the use of the bonus income reports in more detail.
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 5.3.8 Variable Bonus Income Report. 

In the previous section we worked through an example Variable Bonus Income 
report to explain the row display format. In this section a more detailed explanation 
is presented. 

This report introduces maximum flexibility. No assumption is made about the 
relative sizes of the bonuses or about their frequency. The report is quite complex 
and will be discussed in detail. In particular, the role of the "Anticipated Bonuses" 
will be explained. 

Figure 7  Variable Bonus Income Report.

For the remainder of this section, we will assume that Father is the bonus earner. 
We will begin by explaining a possible way to use the Variable Bonus Income 
report. Then, we will take a look at the computational logic behind it. 

1. Begin to use this report by entering the anticipated bonus income that 
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father will receive in each of the twelve months. We will see that just a 
"reasonable" estimate is enough for XspouseTM to calculate each line of the 
Bonus income table very accurately. Note that, if you do not enter any 
anticipated bonuses, it is equivalent to estimating that the bonus will be 
zero in each month. 

2. Next, click one of the two averaging buttons at the top of the screen 
(whichever is appropriate — see below). This ensures that the Bonus 
income tables for all months are the same. 

3. Now, print out the the Bonus income table (for any month — they are all the 
same). There are several buttons in this report to help you enter bonus 
income. 

At the top of the screen, you will see the following buttons: 

• Replicate — Enter bonus from the currently selected month (the one with 
the yellow cursor) into all twelve months. 

• Average (All) — Enter the average bonus into all twelve months. This type 
of averaging is appropriate in cases when the bonus income may occur in 
any month. 

• Average (> 0) — Enter the average bonus into all months in which the 
bonus is non-zero. This type of averaging is appropriate in cases when the 
frequency, though not the size, of the bonuses is known. For example, the 
bonuses may be paid quarterly. 

• Restore — Undo all changes and restore the monthly bonuses, as they 
were when the report was opened. 

• Erase — Set the bonus to zero in all twelve months. 

At the bottom of the screen, there is another set of buttons. 

• Save — This button saves the currently entered anticipated bonuses as part 
of the case data in the computer's memory. To save this data to disk, you 
must return to the main screen and click "Save File". 

• OK — Same as the preceding button, but also closes the Variable Bonus 
Income report and returns to the main screen. 

• Cancel — Abandons all changes and returns to the main screen. 

• Print — Prints the Bonus income table for the currently selected month. 
Note: When printing the Variable Bonus Income table, it is most convenient 
to select the “Browser” button to view the report in the browser. Using the 
browser view permits selection of viewing and printing ranges (see 
Appendix F Section 22.1.3 Bonus Income Reports. Otherwise if printing 
directly by selecting the “Print” option, the default print setting is “Selection”, 
which comprises 41 rows, beginning with the row highlighted on screen. To 
print out the desired bonus row so that it Is displayed mid-page, place the 
highlight on a row approximately 20 rows above. In this way the print out will 
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display how the support changes if the bonus payments are larger or 
smaller than estimated. 

You can change the print option to “All” if desired in the print dialog box 
when selecting print.

• Print Prior — Prints the Approximated Bonus income table for prior 
marriage(s). The effect of prior marriages is explained in a separate section 
below. 

• Documentation. Clicking this button brings up a dialog that explains, step 
by step, how the current (highlighted) line in the bonus income table is 
calculated by XspouseTM. 

• Browser. This opens up the report at the selected bonus value in the 
browser and allows for setting viewing and printing ranges.

 5.3.9 Multiple Marriages. 

When there have been prior marriages, bonus income received by father or mother 
may trigger a change in support payments paid to or received from a prior spouse. 
XspouseTM deals with such situations by asking the user to type in a sample of 
lines from the Bonus income table for the prior marriage(s), then constructing an 
approximation to the prior Bonus income table. This approximated table may be 
printed out and compared to the original table for accuracy. This approximation is 
usually very accurate. 

To use this feature, open the Variable Bonus Income report and click on "Display 
Table". Now, mouse over the "Prior Relationship(s)" label to display the button and 
click on it. The Prior Relationship(s) Sample Bonus Table appears (Figures 8 and 
9). 

Some suggestions for filling out the Sample Bonus Table. 

• Choose more samples in the range in which you expect the bonuses to fall. 
If you expect father to receive variable overtime income in the range $1,000 
to $2,000 per month, there is little purpose in using a $500,000 bonus as 
one of the samples.

• Choose more samples in a range where the percentages (in the prior 
marriage Bonus income table) vary rapidly, fewer samples in a range where 
the percentages vary slowly. You do not have to fill out the whole table at 
once. Just enter the maximum bonus (currently 750K) on next line after you 
have filled in your bonus range. XspouseTM will not read the table past this 
line. (Hold down the '9' key in the bonus field. The entry will automatically 
top out at the maximum bonus.) 
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• Begin by entering 3 or 4 samples. 

• Print out the approximated table. 

• See where more accuracy is needed. 

• Insert more lines in this range.

• There is a button to insert a line and a button to delete a line. Pressing the 
[Insert] key will also insert a line. 

Figure 8 Mousing over the “Prior relationship(s)” label brings up a button to open the 
prior relationships bonus table.
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Figure 9  If you don't wish to fill the whole table, to finish entering data enter the 
maximum value of 750000 or hold down the “9” key to auto fill this value into the next 
row. This is required as you can't leave blank rows in the table..

Please note the following. Bonus income may reverse the direction of support. 
Suppose that you are in a range of bonuses where the bonus earner is the 
recipient of support (child and/or spousal) from a prior marriage. In such a 
situation, "cost" means a reduction in support received from the prior marriage. 
This causes no problems with spousal support. This is either taxable income 
(recipient) or an adjustment to income (payor). Either way, it is a dollar for dollar 
reduction in the AGI. Spousal support is, similarly, either guideline income or a 
guideline deduction. Once again, dollar for dollar. Child support is different. It is a 
guideline deduction, but not guideline income. Presumably, you will want to 
eliminate from consideration a situation where the "cost' is a reduction in child 
support received from the prior marriage. You can do this by entering zero for 
"CS %" in the sample bonus table for the pertinent range in the "original" table. 

The adjustment for additional support paid for prior marriages as a result of bonus 
income may be toggled ON/OFF with the right mouse button or by pressing the 
space bar while the yellow cursor is positioned on any line in the table for the 
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current marriage. 

 5.3.10 Annual Bonus Income 

This report is a companion to the Variable Bonus Income report described above. It 
allows us to "look back" and calculate what the additional support would have been 
if we had had the ability to look twelve months into the future and include the 
bonuses in the annual income. 

 5.4 Taxes 

Most of the selections on this menu apply to either one spouse or the other. 
Note: In the Professional screen, you must position the yellow cursor on the data 
input column for father or for mother before accessing these selections for that 
spouse. 

 5.4.1 Tax Settings 

When the cursor is in one of the Father's or Mother's data input fields tax settings 
can be changed for that parent via the Taxes>Tax Settings menu option or the “Tax 
Set” on the main tool bar.

Figure 10  Dual entry fields in the tax settings detail window.

The Tax Settings enable you to include or exclude various taxes. All the fields are 
dual-entry fields: You can include or exclude the highlighted tax by clicking the right 
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mouse button or pressing the space bar when highlighting the field or you can type 
in a decimal number between 0 and 10 in place of the include/exclude label. The 
tax in question will be multiplied by that number. The include/exclude toggle is 
equivalent to a numerical value of one and zero respectively being entered. To 
reset a numerical value to the include/exclude setting press the space bar or right 
mouse button when in the field.

Using numerical values in the state taxes input fields can be used to estimate out-
of-state taxes.

 5.4.2 Party Tax Information

Selecting this menu item allows you to indicate whether one of the parties or their 
new spouse is aged over 65 or blind. It also allows you to indicate whether in the 
case of married filing separately the two spouses lived together for any part of the 
year. This input window is also available via the File>Party Tax Information menu 
item.

 5.4.3 Tax Credit Override 

Enables you to manually suppress the credits calculated by XspouseTM. All the 
fields are toggle fields. 

 5.4.4 Alternative Minimum Tax Data 

You can enter appropriate additional data for the calculation of the Alternative 
Minimum Tax. 

 5.4.5 MFS Deductions 

IRS regulations state that if a spouse chooses the filing status Married Filing 
Separately, then that spouse must itemize deductions if the other spouse itemizes 
deductions. This selection opens a dialog that enables you to set the correct 
deduction method for the spouse in question. 

 5.4.6 Federal Tax Forms State Tax Forms 

These reports document, line by line, the tax calculations that XspouseTM 
performs. 
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 5.5 Tools – Present and Future Value Calculators 

The Present Value calculator allows the user to do one of two things: 

• Calculate the present value of a stream of payments. 

• Structure a stream of payments to produce a desired present value. 

The choice between the two functions is made through a toggle at the bottom of 
the calculator window. 

You'll notice that one of the fields (either the Payment Amount or the Present 
Value) always has a white background. This is the field that is calculated when 
data in the other fields is modified. 

Analogous comments apply to the Future Value calculator. 

The Future Value calculator has one other feature which needs explanation. In 
addition to the Begin and End dates, there is a Valuation date. As the name 
suggests, this is the date on which the future value is calculated. By default, the 
Valuation date will always track the date of the last payment. When this behavior is 
in effect, there is a blue asterisk '*' next to the Valuation date. If you wish to use a 
Valuation date other than that of the last payment, simply type it in. The asterisk 
will disappear and the Valuation date will remain fixed from then on. To restore the 
automated Valuation date, highlight it with the yellow cursor and press the asterisk 
'*" key. 

  Comments. 
The calculators are available in the Desktop XspouseTM and XarrearsTM. 

If the payment frequency is semi-monthly, an additional field labeled Semi-monthly 
Day appears. This is the date of the month on which the second payment is made. 
It must be a number between 1 and 28. 

The Present Value (or Future Value) field becomes invisible if an error condition 
exists. 

Some examples are: 

• The begin date is before today's date. 

• The payment frequency is semimonthly but the Semi-monthly Day is not 
between 1 and 28. 

• One or more of the dates are invalid. 
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 6 Toolbar 

 6.1 Open

 6.2 Save

 6.3 Clear

 6.4 Print 

The function of each of these icons is self-explanatory. 
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 6.5 Detail

When the yellow cursor is positioned on one of the raised data input cells on the 
main screen, this icon will open the associated Detail window. Generally, it is 
simpler to double-click on the cell or press the D shortcut key to open the Detail 
window. 

Several of the Detail windows merit special comment. 

 6.5.1 Child Detail Window

Figure 11  Child detail window. 

This detail window must always be used in cases of split custody. This is because 
XspouseTM needs to know the order of the children (by age) for the Findings and 
Rebuttals report. Entering the total number of children with father and mother in the 
main screen would not be enough. 
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In the Child Detail, you will see the following fields: 

1. The Child's name

2. Child’s date of birth—in most cases it is sufficient to just enter the year of 
birth provided that the children are entered in age order.

3. The custodial parent. This is a "Toggle" field. You can right-click on it to 
change it. 

4. The next three fields work together. The default is 73.0 days per year. 
However, you can toggle the "days" and the per "year".  

5. The last field allows you to set the non-custodial time explicitly. 

This Child Detail window also has several features to help compute timeshare. 

1. Click on the "Table" button. The current Santa Clara Timeshare Table is 
displayed.

2. Click on the "Worksheet" button. The Timeshare Worksheet is displayed 
(see the following section and the tutorial in Appendix C). 
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  Timeshare Worksheet 
The timeshare worksheet is available inside the Child Detail window (button on the 
extreme right inside the detail window). 

Figure 12  The Timeshare Worksheet. 

There are two modes in the worksheet. 

1. Hours mode – Enter hours into a single day by typing. The whole day can 
also be selected or deselected by right-clicking the mouse or by pressing 
the space bar. 

2. Santa Clara mode – In this mode, the time units are ¼ days, as in the 
Santa Clara rules on timeshare. Right- clicking the mouse or pressing the 
space bar adds a ¼ day to the time. Backspace subtracts a ¼ day. The 
numeric keys 0, 1, 2, 3, 4 enter the corresponding number of ¼ days. 

The appropriate mode can be selected in the Settings screen. You can also save 
the mode as the default setting. It will not cause the "Settings Changed" warning to 
go on, since it does not have a direct impact on calculations, just on data input. 

In both modes, use the weekly template at the top of the worksheet to quickly fill 
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out the worksheet. When mousing over just above each of the cells in the weekly 
field, a toggle button appears to hide/show that particular day of the week. 

When you place the mouse cursor immediately to the right of the weekly pattern 
(next to Sunday), another button pops up. Clicking this button clears the weekly 
pattern (the worksheet itself is unaffected).

Similarly, when mousing over the text on the right hand side of the worksheet, 
these become buttons for data entry or deletion.

To enter time into the worksheet, fill out the weekly pattern at the top of the page. 
Then use the column of buttons on the right of the worksheet to paste to the 
Year/Month/Week. 

Clicking on "Year" in the Paste column will paste the weekly pattern to every week 
in the year. Alt/Week 1 pastes to alternate weeks, beginning with Week 1. 
Alt/Week 2 pastes to alternate weeks, beginning with Week 2. Clicking on "Month" 
in the Paste column will paste the weekly pattern to each week of the currently 
displayed month. Clicking on "Week" in the Paste column will paste the weekly 
pattern to the week opposite the button that was clicked. You can also type directly 
into any day in the worksheet. The buttons in the Erase column work in a similar 
fashion. 

By toggling the hide/show buttons above the week day cells at top of screen, 
permits you to selectively paste or erase selected days, without disturbing any data 
in the hidden days. The paste/erase procedure can be repeated as many times as 
is necessary to accommodate visitation plans that change during the year. 

At the top left of the worksheet, you can toggle the parent for whom the time is 
displayed. This toggle is for convenience only. XspouseTM will determine the 
custodial parent when the worksheet is attached. 

When you Attach a worksheet, the time calculated by the worksheet is entered into 
the Child Detail window. The text "Attached worksheet for Child ..." in the top left of 
the worksheet means that the timeshare calculated by the worksheet is being used 
for the child in question. Any manipulation of the timeshare (altering the worksheet, 
entering the timeshare directly or from the timeshare table, etc.) will detach the 
worksheet. The timeshare may remain unchanged, but it is no longer certain that it 
was calculated by the worksheet. 

A detailed worked example is presented in Appendix C.
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 6.5.2 Filing Status Detail Window

Figure 13  Filing Status Detail. 

This window is only available if Domestic Partnership has been selected in the 
Settings screen. The detail window allows the user to choose state filing statuses 
which differ from the federal statuses. 

The filing statuses displayed in the main screen of XspouseTM are always the 

federal statuses. An asterisk `*' next to the filing status indicates that the federal 
status is being used for the state tax calculation. The absence of an asterisk 
indicates that a different status has been chosen for the state calculation. The 

asterisk may be restored at any time by pressing `*' on the keyboard. 

NOTE: Toggling the status in the main screen will automatically restore the 
asterisk. 
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 6.5.3 Exemptions Detail Window

Figure 14  Exemptions detail window. 

On opening Xspouse there is an asterisk (*) next to the "#Exemptions" data cell for 
each spouse. This indicates that Xspouse is automatically tallying all of the children 
both from this relationship and other relationships. If dates of birth are left blank in 
the #of children detail window, the default setting for each child is that each is a 
qualifying child for the child care credit, the earned income credit and the child tax 
credit. If the birthdays are entered, then the program automatically allocates the 
children according to what credits they qualify for. 

Note that if in there are children from other relationships involved (entered via the 
#of children detail window), since age data is not provided, such children are 
assumed to qualify for all of the credits as explained in the previous paragraph. Any 
adjustments need to be made manually in the #exemptions window. 

The detail window also allows you to enter the number of other dependents.
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If you make any changes in the #exemptions window, the asterisk will disappear 
indicating that you are now in manual mode for calculations. To restore the 
automatic calculation mode, press the asterisk (*) key on your keyboard while 
highlighting the parent’s #exemptions field. Returning to automatic calculation 
mode resets the program to automatic mode and removes any manual changes 
that have been made.
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 6.5.4 Other Taxable Income Detail Window

Figure 15  Other Taxable Income detail window. 

The most common types of taxable income (wages and self-employment income) 
can be entered directly into the XspouseTM main screen. Other categories of 
taxable income listed in Form 1040 can be entered in this detail window. 

If one of the parties of this relationship has remarried and is filing a joint tax return 
with the new spouse, there is a similar detail window on the "New spouse income" 
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line. 

NOTE: XspouseTM uses the new spouse income only to calculate taxes. It does 
not count the new spouse income as guideline income. 

In the Other Taxable detail and in the New Spouse Income detail, the last two lines 
allow you to directly manipulate  Subtractions (Line 14) and Additions (Line 16) in 
Form 540. For MFJIN and MFJOUT, the appropriate combined amount is entered 
into Form 540. This feature allows you to exclude selected categories of income 
from  California  income  tax,  yet  allowing  other  categories  (such  as  wages)  to 
remain subject to the tax. 

Note that some income (such as social security income and unemployment 
benefits) is ALWAYS excluded by XspouseTM. You should use the new lines only 
for other types of income that normally would not be excluded. 

For convenience, if you position the cursor on Subtract from state AGI and press 
'=', XspouseTM will enter the sum of all income categories above, with the 
exception of wages, self-employment and social security. 

 6.5.5 Hardship Deductions Detail Window

Figure 16  Hardship Deduction detail window. 

Partial hardships can be entered here. For example, with the father having 2 
children, if 1.5 hardships were awarded to the father, you would change the "100%" 
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above to "75%" (1.5 / 2 = 0.75)

If there is an asterisk (*) next to the data cell, then Xspouse is calculating this value 
for you.  Unless you are an expert in family law, you should leave this automatically 
calculated value alone and move to the next page.  However, if you decide that you 
must enter the data manually, please use the detail window. Once you have 
overridden the automatically calculated value, the asterisk will disappear and you 
are on your own.  

Note that the automatic calculation affects only line 4 (total FC 4071(b) hardship) in 
the detail window.  Any changes to the other lines must always be made manually.  
You can also disable the automatic calculation of line 4 by choosing the "NO" 
option on line 3 and then enter any number that you wish for the hardship. After 
you have exited the detail window, you can restore the automatic calculation of line 
4 by pressing the asterisk (*) key on your keyboard or by resetting the option to 
"YES" in the detail window.  Either of these steps will restore the automatic 
calculation of line 4 and leave the other lines unchanged.

 7 Settings 

Figure 17  The Settings screen. 
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If you change any settings in this window that triggers a “Settings changed” 
warning on the main screen, the font will change to red for the setting in this 
window to make it easier to see which settings have been altered from those 
shipped with Xspouse.

Most of the fields in this screen are toggle fields (right-click on them or press the 
space bar to change the value.) Many of them can be changed directly in the 
Professional screen by the use of shortcut keys (see the section on the 
Professional screen.) 

The guideline child and spousal support fields are dual-entry fields. You can toggle 
to include or exclude each one by clicking the right mouse button or pressing the 
space bar when highlighting the field or you can type in a decimal number between 
0 and 10 in place of the include/exclude label. The calculated guideline support in 
question will be multiplied by that number. The include/exclude toggle is equivalent 
to a numerical value of one and zero respectively being entered. To reset a 
numerical value to the include/exclude setting press the space bar or right mouse 
button when in the field.

All of the fields, except the last one, affect only the Guideline settlement. The last 
field (concerning the release of exemptions) affects only the Proposed settlement. 

Guideline non-deductible (child) support is a dual-entry field: you can include or 
exclude child support (by right-clicking or pressing the space bar), or you can type 
a number into this field. The calculated child support will be multiplied by whatever 
number you have typed in. Include is equivalent to typing in 1.0000. Exclude is 
equivalent to typing in 0.0000. 

Guideline deductible (spousal) support is also a dual-entry field: you can include or 
exclude spousal support (by right-clicking or pressing the space bar), or you can 
type a number into this field. The calculated spousal support will be multiplied by 
whatever number you have typed in. Include is equivalent to typing in 1.0000. 
Exclude is equivalent to typing in 0.0000. 

Computation method for child support is a toggle field with two possible values: 
Guideline and User CS. If you choose User CS, the User icon will be active when 
you return to the Professional screen. 

Display FC 4055 (b)(7) low-income CS adjustment range allows you to decide 
whether to display (in the Professional screen) the child support range described in 
the Family Code. The best way to see how this works is as follows. 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 49 of 118

  Example 12
Give father a guideline net below 1500 (900, say). Now go back in this 
manual to the description of Shortcuts (see Data Input) and read the 
description for the shortcut key R. 

Computation method for spousal support has several possible values: 

• Santa Clara 

• Alameda 

• Marin 

• Kings 

• San Diego 

• Humboldt

• Yolo

• User SS 

• Formula SS 

If you choose either User SS or Formula SS, the User icon will be active when you 
return to the Professional screen. 

The field Allocation method for child care expenses allows you to control how 
mandatory addons to child support are calculated. See the section on the Findings 
screen for more on this subject. 

The next three lines are concerned with adjustment for the tax consequences of 
spousal support. There is a detailed discussion of this subject in Appendix A. 

For the explanation of the field labeled "Timeshare worksheet mode", see the 
description of the timeshare worksheet under Detail Windows > Child Detail. 

The remaining fields in the Settings are straightforward. The only ones that require 
comment are the two lines pertaining to the limitation of hardship. For these 
settings to have an effect, automatic recalculation must be active on the Hardship 
line in the Professional screen. See Data Input for a description of automatic 
recalculation. You can use the two lines pertaining to hardship to enter fractional 
hardships. For example, if father has 2 hardship children and you wish to enter 1.5 
hardships for father, type in 75% (1.5 divided by 2) in father's column in the 
Settings screen. However, it is usually more convenient to enter hardships directly 
in the Hardship detail window in the main screen. 
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 7.2 Low Income Adjustment Threshold
Assembly Bill 2393 increases the low income adjustment threshold from $1,000 to $1,500. This Bill 
also requires that the threshold be adjusted annually on March 1 by an amount determined by the 
Judicial Council, based on the change in the annual California Consumer Price Index.
To support the requirements of the Bill, Xspouse has implemented the following:

 The low-income adjustment threshold has been increased to $1,500, effective January 1, 
2013

 Automatic adjustment of the threshold on March 1 each year based on the CPI
 The ability to manually switch off the automatic CPI adjustment to allow the user to revisit 

an old case in which the CPI adjustment is not applicable
This addendum explains how to use the LIA with and without the CPI adjustment.

 7.2.1 Important Note

The Xspouse default setting is to automatically adjust the low-income threshold on March 1 each 
year in accordance with the annual change in CPI.  As explained in this addendum, the CPI 
adjustment can be switched off, but switching it off will remain in effect only while the low-
income range is displayed and the “Settings changed” warning is being displayed.

The low-income adjustment settings can be changed either through shortcut keys or through the 
Settings screen.
In the Professional screen, the following shortcut keys have the effect described on the right.
R [Range] Toggles the display of the FC 4055 (f)(7) low-income range of 

child support at incomes when this is applicable. When this feature is 
active, pressing Ctrl+R in the Professional screen will toggle the 
Guideline child support between the high and low ends of the range.

Note: Using R to switch off the display of the low-income support range 
will also switch the automatic CPI adjustment to YES (the default 
setting)

L [Low] Toggles the automatic CPI adjustment of the low-income 
adjustment threshold. Switching the automatic CPI adjustment to NO 
automatically switches the child support range display to YES and the 
red Settings changed alert is displayed.

These settings can also be changed in the Settings screen:

The YES/NO settings can be toggled in the Settings screen by clicking the right mouse button on 
the YES/NO option or by pressing the Space Bar when highlighting the option.
Note the following:

 If the “Apply annual CPI increase to low-income CS adjustment threshold” is toggled to NO, 
then the “Display FC 4055(b)(7) low-income adjustment range” is automatically set to YES 
and the Settings changed warning is displayed. 
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 If the “Display FC 4055(b)(7) low-income adjustment range” is toggled to NO, then the 
“Apply annual CPI increase to low-income CS adjustment threshold” is automatically set to 
YES (the Settings changed warning may continue to be displayed if other settings have 
been changed).

 8 Tax Settings 
The Tax Settings enable you to include or exclude various taxes. All the fields are 
dual-entry fields: you can type in a number. The tax in question will be multiplied by 
that number. Include is equivalent to typing in 1.0000. Exclude is equivalent to 
typing in 0.0000. See Section 5.4.1 for details.

To see the effect of changed Tax Settings, switch the View to either Tax Summary  
(income taxes) or Tax Summary (employment taxes). 

 9 Tactic 
This icon opens dialogs that allow you to manipulate the Proposed settlement. The 
best way to find out what the tactics do is to try them. If the View in the main 
screen of XspouseTM is Cash Flow, then the primary effect of the selected Tactic is 
displayed in blue among the numbers on the right of the screen. 

 10 Findings 
Opens the Findings and Rebuttals report. See the section on Reports for a detailed 
description of this screen. 

 11 Wiz/Pro 
Toggles the input screen between the data input Wizard and Professional screen. 

 12 Tax Documentation 
XspouseTM calculates taxes by following the federal and state tax forms exactly, 
line by line. All the tax forms are displayed, wherever taxes are calculated – in the 
main screen, in the bonus income reports and in property division. 

The tax forms display a blizzard of numbers. However, the numbers that count – 
the federal and state income and employment taxes – are easy to find. 

You can see a summary of taxes in the main screen by changing the View to Tax 
Summary (income taxes) or Tax Summary (employment taxes). 

The tax forms are extremely useful when trying to reconcile differences in numbers 
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with opposing counsel. In many cases, such differences are the result of different 
tax calculations. It is much easier to pinpoint the reason for such differences by 
looking at the tax forms rather than at the data input. Please refer to the section on 
Data Input at the beginning of this manual. 

Figure 18  IRS Form 1040.
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Figure 19  FTB Form 540. 
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 13 Property Division 
The property division module is available via a new main menu selection (next to 
File) in the main screen of XspouseTM. The After Tax columns in the property 
module have been integrated with the support module. 

Figure 20  The Property Screen.

  Property Module Buttons. 
  General: 
Open Opens a file 

Save Saves a file 

Clear Clears the property screen 

Print Brings up the property print menu 
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  Insertion/Removal of Items: 

Next Inserts a blank item after the current item 

Prev Inserts a blank item before the current item 

Delete Deletes the current item 

  Before Tax Columns: 

Cash:% Switches between dollar splits and percentage splits 

Husb Shifts all the equity to Husband 

Equal Splits the equity equally between Husband and Wife 

Wife Shifts all the equity to Wife 

Ignore Removes the item from consideration when computing the 
Equalizing Payment 

  After Tax Columns: 

Basis Switches the Tax Basis between the FMV and a user specified 
number 

Gain Flags the item as a capital gain. Any appreciation is adjusted 
using the capital gains brackets 

Loss Flags that a loss will be taken for the item if there is a loss. 
There is no effect in the absence of a loss. Any depreciation is 
adjusted using the appropriate tax brackets. The overall 
limitation on capital losses is only applied when computing the 
Equalizing Payment. It would be misleading if applied to 
individual items. 

Calc[ulation] Allows the user to select the Guideline settlement or the 
Proposed settlement as the context in which the after-tax value 
of property is calculated. The tax forms documenting the 
calculations are available under Taxes > Tax Forms. Estimates 
by tax brackets remain available for comparison with earlier 
versions of XspouseTM. 
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  Worksheets: 

Pens Pension worksheet 

Mars Marsden worksheet 

The panels of buttons at the extreme right of each item in the desktop version of 
XspouseTM, duplicate the actions of many of the above buttons. Click the Change 
button at the top right of the screen to change the displayed panel. The first panel 
consists of the buttons [h][w][=][I]. These buttons distribute the property item to 
husband, to wife, equally, or ignore the item. The second panel comprises the 
buttons [b][g][l]. These buttons duplicate the After Tax buttons described above. 
The third and final panel is informational; it displays blue uppercase letters such as 
M to indicate a Marsden item, P to indicate a pension item, G to indicate a long 
term capital gain and L to indicate a loss item. 
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 14 Arrearage Calculator 
The arrearage calculator XarrearsTM is a separate program which is installed as 
part of the XspouseTM package of files. After installation, there will be an icon  
under the XspouseTM icon on your Start > All Programs menu. 

Figure 21  XarrearsTM main screen.

The arrearage calculator contains an online manual. Each screen in the program 
has a "Help" button. Clicking on this button brings up text which explains what that 
particular screen does. In particular, the "Help" button in the main screen describes 
how to begin a new case.  A tutorial example is presented in Appendix G.
  Notes. 

1. When you enter a semi-monthly payment schedule, a field titled "Semi 
Day" will appear. This means the date of the second payment in the 
month. This date must be between 1 and 28. 

2. The default interest rate is 10%, effective on January 1, 1980. Click on 
the "Interest Rates" button if you wish to modify this. 
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 15 Appendix A 

 15.1  Adjusted Nets 

The adjective "adjusted" refers to the adjustment for the tax consequences of 
spousal support. The following discussion applies only to spousal support. Child 
support is always calculated using unadjusted nets, as defined in FC 4058 and 
FC 4059.

Spousal support is an adjustment to income for the payor and taxable income for 
the recipient. This results in a tax saving for the payor and a tax liability for the 
recipient. Effectively, the guideline net income of the payor is increased by the 
amount of the tax saving; and the guideline net income of the recipient is reduced 
by the amount of the tax liability. 

If we apply the guideline spousal support formula to these new nets, we get a 
different spousal support than previously. Once again, this new spousal support 
results in a (new) tax saving for the payor and a (new) tax liability for the recipient. 
This can be done indefinitely. More precisely, we begin with the unadjusted nets 
(FC 4058 and FC 4059) and then repeat the following steps over and over. 

1. Apply the spousal support formula to the guideline nets to calculate spousal 
support.

2. Adjust the nets for the tax consequences of the calculated spousal support. . 

It turns out that, after relatively few repetitions (or iterations), the changes in the 
spousal support become very small (less than $1). Once this happens, we 
terminate the iterations. The guideline nets in Step 2 above (of the final iteration) 
are called the adjusted nets. The spousal support calculated by the guideline 
formula from these nets is called the adjusted support. 

 15.2 Fixed Shares vs. Floating Shares. 

There are two common variations of the above. 

First, we recall a definition. Net disposable income (after support) is defined as 
guideline net, minus amount allocated for child support, minus spousal support 
paid (or, plus spousal support received, in the case of the recipient of spousal 
support). Adjustment of the guideline nets for the tax consequences of spousal 
support, described above, generally results in an increased net disposable income 
for the payor and a decreased net disposable income for the recipient. 

Floating Shares allows the foregoing to occur, without attempting to modify the 
changes in disposable incomes. 
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Fixed Shares, on the other hand, restores the ratio of net disposable incomes to 
the original, unadjusted, value. This is done by adding an additional payment (the 
equalizing payment) to the spousal support calculated using the guideline formula. 
The iterations for fixed shares thus have an one more step (Step 3 below). 

1. Apply the spousal support formula to the guideline nets to calculate spousal 
support.

2. Adjust the nets for the tax consequences of the calculated spousal support.

3. Calculate the equalizing payment necessary to restore the ratio of the net 
disposable incomes to the original value (based on unadjusted nets). 

4. Add this equalizing payment to the support calculated in Step 2. 

Again, the iterations are repeated until the adjustments become very small. 

 15.3 Negative Adjusted Nets. 

The recipient of spousal support will incur a tax liability because of the spousal 
support. This will be true even if recipient has little or no income to begin with. In 
such cases, the tax liability may make the adjusted net negative. This does NOT 
mean that recipient has "negative income". Adjusted net is NOT the same thing as 
net disposable income after support. The adjusted nets have been adjusted for the 
tax consequences of spousal support, but not for the spousal support itself. If 
spousal support is included, the net disposable income after support will always be 
positive if the net disposable income before support is positive. 
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 16 Appendix B 

 16.1 DPRRA in XspouseTM 

The Domestic Partner Rights and Responsibilities Act of 2003 (DPRRA) in 
XspouseTM. 

The tax behavior of spousal support (traditional or DPRRA) is handled 
automatically by XspouseTM. 

 16.1.1 Tax Treatment. 

1. On the recipient's federal tax return, DPRRA spousal support is alimony 
received. 

2. On the payor's federal tax return, DPRRA spousal support is neither an 
adjustment to income nor a deduction from income. 

3. On the recipient's state tax return, there is no change. [DPRRA spousal 
support is already included in the federal AGI.] 

4. On the payor's state tax return, DPRRA spousal support is listed on 
Schedule CA(540), line 34a, column C (i.e., it is an addition to the federal 
ATIs). 

5. The federal and state tax filing status is the same. 

 16.1.2 DPRRA-related Fields in XspouseTM. 

1. There is a switch in the Settings screen to identify the current relationship as 
traditional or DPRRA. 

2. There are lines in the Other Taxable, New Spouse and Spousal Support 
Paid detail windows to identify the "base" (recurrent) spousal support 
received/paid as traditional or DPRRA. 

3. There may be bonus income tables associated with prior relationships. Such 
tables have a major effect on the bonus income table for the current 
relationship. Once again, it is necessary to identify any additional spousal 
support that is triggered by a bonus as traditional or DPRRA. There is a 
column in Reports > Variable Bonus Income > Prior Relationships to allow 
the user to make this identification. 

4. The tax forms are conveniently accessible wherever there is a need for 
complete tax documentation (e.g. the main screen, bonus income, property 
division). The user can toggle between federal and state forms. There is a 
supplemental second page to Schedule CA(540) to document the effect of 
DPRRA spousal support on California taxes. [The supplemental second 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 61 of 118

page displays columns B and C (subtractions and additions) of this form. 
There is not enough room on the screen to display columns A, B, C for both 
the Guideline and Proposed settlements on one page.] 

The tax behavior of DPRRA spousal support is fully documented in the XspouseTM 
tax forms (accessed via Taxes > Tax Forms). In particular, see Federal Form 1040, 
State Form 540 and State Schedule CA(540). The last-named has a supplemental 
Page 2, on which you will see DPRRA spousal support (both current and prior 
relationships) listed as an Addition to Federal Adjustments for the payor. [This 
Page 2 does not exist in the real Schedule CA(540). It documents pertinent lines of 
Column B and Column C of the real form.] 
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 17 Appendix C 

 17.1 Timeshare Worksheet Tutorial 

When the timeshare worksheet is first opened the display shows a row of days of 
the week across the top, called the “weekly template”, the calendar month that has 
been selected by the tabs at left, and two columns labeled “Paste” and “Erase” at 
right of the display (Figure C1). Mousing over any of the right column text displays 
and input button. This is discussed below.

Figure C1  Timeshare Worksheet (no data entered).

There are two modes of data entry in the timeshare worksheet – Hours and Santa 
Clara. In the latter mode, the units of time are ¼ days rather than hours. The mode 
may be selected in the program Settings screen (Figure C2). 

When the mode is set to Santa Clara data can be entered in to any day by either 
right mouse button clicking on the day to scroll through ¼, ½, ¾, All, or 0 days, or 
by pressing the space bar to scroll through the options. Alternatively you can press 
the 1-4 numerical keys to select the number of quarter days. If another numerical 
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key is pressed an asterisk (*) will be displayed indicating an invalid data entry.

Figure C2  Timeshare Worksheet data entry mode selection in the Program Settings screen.

When the mode is set to Hours in the settings screen, right mouse button clicking 
on a day or pressing the space bar will toggle the input value between 24 hours (all 
day) and zero hours. Data can also be entered manually on an hourly basis.

In either data entry mode the value can be returned to zero by toggling the right 
mouse button on the day to reset the value to zero or alternatively by clicking the 
left mouse button on the day followed by pressing the numerical “0” key.

When entering data, begin by entering a timeshare arrangement into the weekly 
template at the top of the screen. Then  click one of the buttons in the Paste 
column to paste the arrangement into the calendar – clicking "Year" will paste the 
template into every week of the year, clicking Alt/Week 1 or Alt/Week 2” will paste 
the timeshare template data in to alternative weeks for the whole year, beginning 
with the first week of the year. Clicking "Month" will paste into every week of the 
displayed month and clicking "Week" will paste into the week opposite the clicked 
button. The buttons in the Erase column work in an analogous manner. 
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In the following example, the Hours mode is used. 

We will enter the following timeshare arrangement (all times are with father). 

1. Alternate weekends, with 12 hours on Saturday and 12 hours on Sunday.

2. 8 hours every Tuesday.

3. A 1-week camping trip with father in July. 

When entering (3) above, we will deliberately make a "mistake" and initially enter 2 
weeks. This will give us an opportunity to show how to erase the "erroneous" week.

Let's now begin the example. The first step is to enter 12 hours into both Saturday 
and Sunday in the template (Figure C3). 

Figure C3  Timeshare Worksheet (weekend entered into template). 

We now click the "Alt/Week 1" button. This pastes the template into alternate 
weekends, beginning with Week 1 Figure C4). 

We next turn our attention to entering "every Tuesday" for the year. 
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We begin by entering 8 hours into Tuesday in the template. However, we now face 
a problem. If we click the "Year" button, we will paste the template into every week 
of the year, overwriting the "alternate weekends" that we have previously entered. 

Figure C4  Weekend pasted in to worksheet. 

To overcome this problem position the mouse pointer on the “Hide” button above 
Saturday in the template. Clicking on this button will make Saturday "invisible". We 
do the same thing with Sunday. Such "invisible" days in the template do not affect 
pasting or erasing in the calendar. Clicking the buttons above the template a 
second time will make the days "reappear" again (Figure C5).

Now that Saturday and Sunday are safely "invisible" in the template, we can click 
the "Year" button in the Paste column to paste the 8 hours on Tuesday (in the 
template) into every week in the calendar (Figure C6). 
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Figure C5  Tuesday entered in to template and Saturday and Sunday have been made 
“invisible” by clicking the “Hide” buttons as shown..

 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 67 of 118

Figure C6  Tuesday pasted into worksheet (every week) whilst Saturday and Sunday are 
made “invisible” in the weekly template at top of screen. 

We are now going to enter the camping trip in July. 

The first step is to select each entire day in the template. Simply right-click on each 
day or type in 24 hours in each day in the template (Figure C7). 
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Figure C7  Entire week entered into template and July is selected on the tabs at left. 

In the Paste column, click the "Week" button for week beginning July 4 in the 
calendar. 

Now, make a deliberate "mistake" and paste a second week by clicking the "Week" 
button for week beginning July 11 (Figure C8).

We correct our "mistake" by clicking the "Week" button in the Erase column 
opposite the week beginning July 11 (Figure C9).

The erasure of the week beginning July 11 has also erased our Tuesday and one 
of our "alternate weekends". 

We fix this by directly typing 8 hours into Tuesday July 12, and 12 hours into July 
both Saturday 16 and Sunday July 17 (Figure C10). 
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Figure C8  Two week camping trip entered accidentally rather than one week in July. 
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Figure C9  Second week of camping trip in July is erased by pressing the erase button for 
that week. This also erases the Tuesday and weekend entries for that week and corrected 
manually (Figure C10).
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Figure C10  The 8 hours for Tuesday 12 and the 12 hours for the alternate weekend for 
the week beginning July 11 is reentered manually to finalize the correction. 

Before closing off this example, it should be noted that the timeshare worksheet 
details can be applied to all children by pressing the button “Apply to all children” at 
bottom of screen. Alternatively, if different timeshare arrangements are in place for 
the individual children, each child's timeshare worksheet can be attached to the 
case details. When multiple child worksheets are attached, the average timeshare 
for all children is calculated and displayed on the main screen.

 17.2 Timeshare worksheet browser view and printing

 17.2.1 Browser preview for child(ren) timeshare

The child(ren) timeshare views can now be opened in your browser. To open the 
timeshare views in your browser, click on the "Browser" button that has been 
added to the timeshare window in Xspouse. 

The first page that will open after you click on the "Browser" button in Xspouse will 
be the list of children. 
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An ellipsis (...) beside a child's name indicates that more information is available by 
clicking on the ellipsis. For example, if the child's timeshare was set using the 
"Table" option, then clicking on the ellipsis beside that child's name will show which 
option in the table was selected for the child. 

Similarly, if the child's timeshare was set using the "Worksheet" option, then 
clicking on the ellipsis beside that child's name will display the worksheet for that 
child. The browser display is interactive and you can click on any month or either 
parent to see that month's and/or parent's data. 
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Printing a worksheet from the browser will allow you to choose whether to print just 
this month for the currently selected parent (this is the default print setting), or to 
print all months and/or print for both parents. 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 74 of 118

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 75 of 118

 18 Appendix D 

 18.1 Creating a Backup Disk 

1. Install XspouseTM in a empty directory and personalize it (by running it 
once). 

2. Copy all the files from the XspouseTM directory onto a blank CD. 

If you ever need to restore XspouseTM , simply copy all the files from the CD back 
into the XspouseTM directory on your computer. 
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 19 Appendix E 

 19.1 Uniform Child Support Guideline 

The following example describes pictorially the logic behind the Guideline Child 
Support formula. 

  Scenario Information 
Number of children is 3, all with mother. 

Non-custodial percentages (with father) 

Huey 30.00%

average with father is 30.00%Louie 40.00%

Dewey 20.00%

Non-taxable income per month 

Father $7,000 

Mother                      $2,000   

Total Net $9,000 

  Step 1 Calculate the K-factor 
Look up the K-factor corresponding to the total net of $9000 in the table in FC 
4055(b)(3) 

K = 0.27444 

Now multiply this value of K by the multiplier for 3 children (2.0) listed in the table in 
FC 4055(b)(4) to get a new value (after rounding) 

K = 0.5489 

This last value is the fraction of each parent's net that will be allocated (contributed) 
for the support of the children. 

K = 0.5489 

  Step 2 Allocate amount for support 
The amount allocated (contributed) for child support from each parent's net is: 

From father: 7000 x 0.5489 = 3842 
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From mother: 2000 x 0.5489 = 1098 

From father $3,842

From mother $1,098

Total $4,940

  Step 3 Divide between the 3 children 
The total amount allocated for child support is now divided equally between the 3 
children. Each child gets a third of the $4940, or $1647 (rounding to the nearest 
dollar). 

Huey

$1647

Louie

$1647

Dewey

$1647
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  Step 4 Distribute to parents 
The amounts in Step 3 are now distributed to the parents (on behalf of the children) 
according to the percentage of time that the children spend with each parent. 

Huey 

$494

30%

$1,153

70% 

Louie 

$659

40%

$988

60% 

Dewey 

$329

20%

$1,318

80% 

The total distributions to the parents are: 

To father: 494+659+329 = 1482

To mother: 1153+988+1318 = 3459 

To father: $1482 

To mother: $3459 
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  Step 5 Alternative (but equivalent) distribution 
Alternatively, we could have distributed the total amount allocated for child support 
($4940) by using the average percentage of the time that the children spend with 
each parent. The average time with father is 30% and with mother is 70%. 

Before distribution 

$4,940

After distribution 

$3,458

70%

$1,482

30%

The total distributions to parents are the same as in Step 4. (There is a $1 
discrepancy for mother because of rounding.) 

To father: $1,482

To mother: $3,458
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  Step 6 Calculate the child support 
Father contributes $3,842 for the support of the children (Step 2). He gets back 
$1,482 for the time that the children are with him (Step 5). Thus his net payment is 
3842 - 1482 = $2,360 

Father pays $2,360 

A similar calculation shows that the mother's net payment is 1098 - 3458 = - $2,360 
(mother receives $2,360). 

Mother receives $2,360 

Now enter the scenario information (at the beginning of this Appendix) into 
XspouseTM. You will see that 

Child support is $2,360 

 19.2 Technical Remarks 

The following remarks are for those XspouseTM users who are interested in the 
algebraic expression of the above example. 

(1) In the description below, high-earner and low-earner are substituted for 
father and mother but the logic is unchanged. 

Notation is as in FC 4055: 

TN = total net 

HN = high-earner net 

H% = average time with high-earner 

and, additionally, analogous notation for the low-earner: 

LN = low-earner net 

L% = average time with low-earner 

The logic of the above example can now be expressed algebraically. 
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  Step 1 Calculate the K-factor 
The K-factor K is calculated as before, by looking up the tables in FC 
4055(b)(3) and FC 4055(b)(4) for the appropriate number of children. K is 
the fraction of each parent's net that will be allocated for the support of the 
children. 

  Step 2 Allocate amount for support 
The amount allocated (contributed) for child support from each parent's net 
is: 

From high-earner: K x HN 

From low-earner: K x LN 

The total amount allocated (contributed) is the sum of the above 
contributions from each parent: 

(K x HN) + (K x LN) 

which may be rewritten as 

Total amount allocated is: K x TN (because HN + LN = TN) 

  Step 3 Distribute total allocation to parents 

The total amount (K x TN) allocated in Step 2 is now distributed to the 
parents by using the average time that the children spend with each parent. 

To high-earner: (K x TN) x H% 

To low-earner: (K x TN) x L% 

  Step 4 Calculate the child support 
The net payment by high-earner is the amount contributed (Step 2) minus 
the amount distributed (Step 5): 

Net payment by high-earner = (K x HN) – (K x TN x H%) 

Net payment by high-earner = K x (HN – TN x H%) 

For low-earner, we have a similar result 

Net payment by low-earner = K x (LN – TN x L%) 
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However, if we use the fact that TN = HN + LN and L% = 1 – H%, we can re-
write this as 

Net payment by low-earner = – K x (HN – TN x H%) 

Thus, the net payment by low-earner is the negative of the net payment by 
high-earner. The low-earner receives what the high-earner pays (or vice 
versa). Compare these results with the Guideline Child Support formula in 
FC 4055. 

(2) In the example, it was stated that Steps 3 and 4 were equivalent to Step 5. 
This was assumed in the algebraic explanation above. The equivalence can 
be established by a straight-forward algebraic argument. It is not presented 
here. 

(3) Strictly speaking, the K-factor is only defined for one child in FC 4055. 
However, the result is identical (mathematically) whether the child support 
formula is applied first and then multiplied by the multiplier from FC 4055(b)
(4) or the K-factor is multiplied first by the multiplier from FC 4055(b)(4) and 
then the child support formula is applied. This extended definition of the K-
factor allows us to talk about the amount allocated for the support of more 
than one child. 
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 20 Appendix F 

 20.1 Database Connectivity 

XspouseTM has the ability to save files to a database. There is a new menu 
selection Database (next to File). Some of the highlights are: 

• XspouseTM can connect to a database over both intranets and the Internet. 

• Security is entirely under the control of your system/database 
administrator(s). 

• XspouseTM supports all major database systems (SQL Server, Oracle, etc.) 

• The XspouseTM database, being a well-known format, can be read by other 
programs. 

  Important Notes: 

1. It is not necessary to install the database to run XspouseTM. If you have not 
installed the database but accidentally click on one of the database 
operations (for example, Save Record), XspouseTM will look for the 
database for 60 seconds. During this time, the program will appear to be 
frozen. Please be patient. After 60 seconds, it will resume functioning 
normally. 

2. When saving a case to the database for the first time, use New Record 
(under the Database menu selection). Subsequently, use Save Record. This 
convention greatly reduces the chances of saving a record with an incorrect 
case number. 

• If you get an error when trying to retrieve a record from the database 
with Get Record, it is probably because the case number does not 
exist in the database.

• If you get an error when trying to save a record with Save Record, it is 
probably because the case number does not exist in the database 
yet.

• If you get an error when trying to create a record with New Record, it 
is probably because the case number already exists in the database. 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 84 of 118

 21 Appendix G

 21.1 Xarrears Tutorial Example

 21.1.1 Input and settings screens

Figure G1  Xarrears main screen before any payment data has been entered.  

When Xarrears is first opened you will see a set of five blue input buttons aligned 
horizontally and a set of four tabs arranged vertically along the left border.  The buttons 
are for entering regularly scheduled items that are part of a support order, the tabbed 
pages are for unscheduled items.

To begin a new case type in the Application date in the display box at bottom right of 
screen. 

You cannot enter other data directly into this screen.  To enter regularly scheduled 
payments due or made, click on the appropriate button in the main screen.  To enter lump 
sums ordered, unscheduled payments made and costs, go to the appropriate tabbed page 
in the main screen.
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Figure G2  The Settings screen allows you to choose whether simple or compound interest rates are 
to be used in calculations, whether lump sums ordered should be treated as part of the current order, 
whether over payments be applied to future amounts due and other parameters as shown above. 

If you use particular settings regularly you can save them to disk by pressing the Save button and 
retrieve them at any time by pressing the Load button.  The Reset button resets program 
default values.
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Figure G3  In the Interest Rates screen you can set the effective date and interest rate 
for any period(s) within the arrears calculation.  The interest rate on each line remains 
in effect from the date on that line until the date on the next line or if no additional line, 
then to the Application date.

The default interest rate is set at 10% effective from January 1, 1980.

If you use a table of interest rates regularly you can save it to disk by pressing the Save 
button and recall it at any time by pressing the Load button.

When setting up a table of interest rates use the Add Next or Add Previous buttons to 
continue adding data.  When finished, press the Enter key or the OK button to return to 
the main screen.

Any item with an invalid date will be discarded when leaving this screen.
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Figure G4  Commence by entering the scheduled payments.  Press the Add Next button to 
display the first data entery row.  At any time a new row can be added above or below the 
currently selected row by pressing the  Add Prev or Add Next buttons.  The Delete button 
deletes the currently selected row.

The payment period can be changed by right mouse clicking in the Period input field or by  
pressing the space bar when in that field.  Available payment periods are: monthly; semi-
monthly; weekly; and bi-weekly.  When the period is set to semi-monthly, an additional 
input field is displayed in which the day of the month on which the second scheduled 
payment for the month is to be paid.  Valid input is in the range 1-28.

A series of regular scheduled payments or payments made, can be entered in a single line 
entry by selecting appropriate Begin and End dates as shown in this figure.  The result of 
the input displayed in this figure is shown in Figure G5.
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Figure G5 Scheduled payments table automatically created by Xarrears from the single 
line of data shown in Figure G4.  Use the scroll bar at right to move up and down in the 
table to view all of the data.
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Figure G6  An example of scheduled payments some of which were fully met, some 
partially and others not paid at all.  To select the partial or full obligation, right mouse 
click on the input field or press the space bar when the input field is highlighted.  

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 90 of 118

Figure G7  To enter unscheduled payments or lump sums ordered use the tabbed windows  
on left of screen.  When finished entering data, select the All Items tab to return to the 
main screen.
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Figure G8 Showing how Xarrears displays the data presented in the input screens in 
Figures G6 and G7. Note that the gap in scheduled payments and the unscheduled lump 
sum payment made on 5-1-2008 as per the data entered shown in Figures G6 and G7.
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Figure G9  The print range and calculation range in Xarrears is set by the initial Begin 
and final End dates in the Payment Schedule screen.  So the entered data displayed in 
Figures G6 and G7 would only print and use for calculation data in the date range 1-1-
2007 to 1-1-2010 (Figure G4) and would not print or use in calculations any of the 
payments made after 1-1-2010 (Figure G6).  To incorporate the additional payments 
made after the last scheduled End date, it is necessary to add an additional line to the 
Payment Schedule screen with an additional new End date showing a zero scheduled 
amount for the period covering the additional payments being made, as shown in this 
figure.
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Figure G10  With the addition of the extra line in the Scheduled payments screen 
(Figure G9) the additional payments beyond the original End date are now able to be 
printed and used in the Xarrears calculations.
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Figure G11  In the Delinquency screen enter dates of delinquency notices on the left.  
Then select items that were on the delinquency notices from the list on the right by 
clicking the push-buttons next to the items.  The list on the right contains all the items 
from the main screen. 

Make sure that you have entered all the scheduled payments ordered and made before 
entering delinquency notices.  If you later change the payment schedule, all delinquency 
notices will be cleared and you will have to re-enter them.

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 95 of 118

 21.1.2 Reports

Figure G12  The Summary table displays the items and balance on all days on which 
there was activity.

The lines in boldface type display the accumulated totals to that date.  The lines in the 
lighter font are items scheduled/paid on that date.
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Figure G13  The Accumulated Totals report displays the accumulated totals on all days 
on which there was activity.

The numbers in the column labeled Payments are the total payments to that date.  The 
numbers in the other columns are the amounts owing on that date.  The numbers in the 
Payments column will always increase as you read down.  The numbers in the other 
columns will fluctuate.  In this particular example in the Total column, the bottom row 
value of 2220 is the same as the total shown on the main screen in Figure G8.
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 22 Appendix F

 22.1 Xspouse browser preview and printing

 22.1.1 Overview

A "Browser Preview and Printing" feature has been added to Xspouse and 
Xarrears. The feature is implemented in the following: 

• All of the items on the main print menu in the Support module of Xspouse. 

• All of the items on the main print menu in the Property module of Xspouse. 

• The annual bonus income report. 

• The variable bonus income report. 

• All of the items on the main print menu in Xarrears. 

The "Browser Preview and Printing" feature allows you to view documents in your 
browser instead of sending them directly to the printer. You can print the document 
from the browser, if you choose to do so. 

The normal print feature (that sends the document directly to the printer) remains 
unchanged. 

The "Browser Preview and Printing" feature brings significant advantages over the 
normal print facility. The advantages include: 

• The ability to have multiple documents open for viewing in your browser. 
This effectively allows you to have multiple, simultaneous views of an 
Xspouse case. 

• Significantly enhanced appearance of reports that are printed via the 
browser preview and print feature. (Note: printing from the Xspouse and 
Xarrears main print menu directly to the printer retains the existing 
appearance of reports; the enhanced appearance reports are available only 
via the browser preview and printing feature). 

• The ability to print from the browser. This will also resolve any printing 
problems that users have occasionally encountered when printing directly 
from Xspouse or Xarrears. 

 22.1.2 How to invoke browser preview

The Browser Preview and Printing feature is available in both Xspouse and 
Xarrears. The following diagrams show how to use the feature in the various 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 98 of 118

places where it is available. 

On the main print menu of both the Support module and Property module of 
Xspouse, there are 2 buttons located below the print options, as shown in the 
following diagram. The function of the 2 buttons is explained below the diagram. 

 

By default, clicking on the "OK" button will send the selected documents to the 
printer. If you select the "View in browser" button before clicking on "OK", then the 
selected documents will be displayed in your browser, instead of being sent directly 
to the printer. You can then print the documents from your browser, if you wish to 
do so. 

Select "Set view in browser as default" if you wish to change the default behavior 
of the "OK" button so that documents are displayed in the browser instead of being 
sent to the printer. The setting will remain in effect until you unselect the "Set veiw 
in browser as default". 

On the Xarrears main print menu, selecting the "View in browser" button before 
clicking on the "OK" button will display the selected documents in your browser, 
instead of sending them directly to the printer. You can then print the documents 
from your browser, if you wish to do so. The Xarrears main print menu is shown 
below: 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 99 of 118

 

 22.1.3 Bonus Income Reports

The Browser Preview and Printing feature has also been implemented for the 
Annual and Variable Bonus Income reports in Xspouse. A "Browser" button has 
been added to each of the reports, as shown in the diagrams below. Clicking on 
the "Browser" button will display the report in the browser, instead of sending it 
directly to the printer. You can then print the report from the browser, if you wish to 
do so. 
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Important note: The bonus income reports require JavaScript to run. By 
default, Internet Explorer may pop up the following warning message. Click 
on "Allow blocked content" to allow the bonus income report to display.

 

The use of JavaScript permits the Bonus Income Reports to be interactive, 
allowing the user to select viewing and printing ranges. 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 101 of 118

The browser version of the variable bonus report (shown below) has a separate tab 
for each spouse. When the variable bonus report first opens in the browser, the 
anticipated bonus for each spouse is automatically displayed as the 2nd line on 
table (light blue background for the first spouse and light red background for the 
2nd spouse). 

The anticipated bonus for the other spouse is displayed at the top right of the 
browser version of the variable bonus report. 

 22.1.4 How to print from browser preview

 22.1.4.1 Chrome 

In Chrome, either press “Ctrl + P” or click on the vertical ellipsis at the top right of 
the browser window, as shown below: 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 102 of 118

 

The print setup panel will appear on the left of the browser window, as shown 
below: 

 

In the print panel, you can select the print destination, as well as other settings. 
Click on 'More settings...' to see additional settings. 

When you ready to print, click on the 'Print' button. 

You may also wish to refer to the topic How to configure headers and footers below 
for an explanation of how to remove Chrome headers and footers. 
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 22.1.4.2 Internet Explorer
In Internet Explorer, you can either press “Ctrl + P” or you can click on the 'File' 
menu and then select 'Page setup...', 'Print...', or 'Print preview...', as shown below: 

 

Each of these options will allow you to configure various aspects of printing. 

You may also wish to refer to the topic How to configure headers and footers below 
for an explanation of how to configure or remove Internet Explorer headers and 
footers. 

When you are ready to print, either click on the 'Print' button in the dialog that 
comes up in response to the 'Print...' menu item, or click the printer icon that is 
located at the top-left of the 'Print preview' window. 
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 22.1.4.3 Microsoft Edge 

To print from Micrsoft Edge, you can either press “Ctrl + P”, or, alternatively, you 
can click the ellipsis icon at the top-right of the browser window, as shown below: 

 

A drop-down menu will appear on the right of the browser window. Click on the 
print icon, as shown below: 

 

The 'Print' dialog will appear. In the 'Print' dialog, click the 'Print' button to print, as 
shown below: 
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You may also wish to turn off headers and footers in the 'Print' dialog as shown 
below. 
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 22.1.4.4 Firefox 

To print from Firefox, you can either press “Ctrl + P”, which will bring up the 'Print' 
dialog: 

 

or, alternatively, you can click the menu icon at the top-right of the browser window, 
as shown below: 

 

A drop-down menu will appear on the right of the browser window. Click on the 
print icon, as shown below: 
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In the print preview window that appears, you can click on 'Print' or 'Page Setup...', 
as shown below: 

 

You may also wish to refer to the topic How to configure headers and footers below 
for an explanation of how to configure Firefox headers and footers. 
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 22.1.5 How to configure headers and footers

When you print an Xspouse report from your browser, Xspouse adds a header and 
footer to the report. In addition to the Xspouse header and footer, browsers may 
add an extra header and footer of their own, which will over write the Xspouse 
headers and footers. These browser default headers and footers can be easily 
switched off with the browser.

This section explains how to change the settings in your browser to exclude, or 
modify, the extra browser header and footer. Chrome, Internet Explorer, and 
Firefox are used as examples. 

 22.1.5.1 Chrome 

In Chrome, you can turn headers and footers on or off in print settings. To view the 
print settings, either press “Ctrl + P” or click on the vertical ellipsis at the top right 
of the browser window, as shown below: 

 

The print setup panel will appear on the left of the browser window. Click on 'More 
settings', as shown below: 
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You can then turn headers and footers on or off by checking or unchecking 
'Headers and footers'. For example, to turn off headers and footers, uncheck the 
box as shown below: 
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Your settings will remain in effect for all printing from Chrome (until you next 
change the settings). 

 22.1.5.2 Internet Explorer 

 Internet Explorer allows you to turn headers and footers on or off, and also allows 
you to configure the contents of headers and footers. Each of these is explained in 
this topic. 

To turn headers and footers on or off just for this print only, click on 'Print preview...' 
in the 'File' menu, as shown below: 

 

In the print preview window, click on the icon that toggles headers and footers on 
and off (you will see the headers and footers disappear/appear in response), as 
shown below: 

XspouseTM User Manual www.xspouse.com

http://www.xspouse.com/


Page 111 of 118

 

That will turn headers and footers on or off only for this particular print job. To either 
turn headers on or off for all print jobs, or to configure the content of headers and 
footers, click on 'Page setup...' on the 'File' menu, as shown below: 
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In the page setup panel, you can configure what appears in each section of 
headers and footers (headers and footers are each divided into three sections; left, 
middle, and right). To turn headers and footers off, set each section to '-Empty-'. In 
the following example, all sections of the header have been set to empty, and the 
footer has been configured to show time of print on the left, page count in the 
middle, and date on the right. 
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 22.1.5.3 Microsoft Edge 

In Micrsoft Edge, you can turn headers and footers on and off in the 'Print' dialog. 
To open the 'Print' dialog, either hold the Ctrl button down and press 'P', or, 
alternatively, you can click the ellipsis icon at the top-right of the browser window, 
as shown below: 

 

A drop-down menu will appear on the right of the browser window. Click on the 
print icon, as shown below: 
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The 'Print' dialog will appear. In the 'Print' dialog, turn headers and footers on or off, 
as shown below: 
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 22.1.5.4 Firefox 
Firefox allows you to configure the contents of headers and footers, optionally 
setting the content to blank. To configure headers and footers, click the menu icon 
at the top-right of the browser window, as shown below: 

 

A drop-down menu will appear on the right of the browser window. Click on the 
print icon, as shown below: 

 

In the print preview window that appears, click on 'Page Setup...', as shown below: 
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In the 'Page Setup' dialog that appears, click on the 'Margins & Headers/Footers' 
tab, as shown below: 

 

In the 'Margins & Headers/Footers' tab, you can configure what appears in each 
section of headers and footers (headers and footers are each divided into three 
sections; left, middle, and right). To turn headers and footers off, set each section 
to '-blank-'. In the following example, all sections of the header have been set to 
blank, and the footer has been configured to show date/time of print on the left, 
blank in the middle, and page count on the right as shown below. 
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